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QE for AFE V2.2.0  

Release Note 

Thank you very much for using the QE for AFE V2.2.0. 

This release note covers product installation, restrictions, and so on. Please read this document before using 
the product. 
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1. About QE for AFE 

1.1 Summary 

QE for AFE is an evaluation tool for embedded system development that performs graphical tuning with an 
integrated analog front end (AFE). Using this tool, you can configure AFE registers, write registers into the 
evaluation board, and monitor the AFE tuning results in a waveform. 

To use this tool, you must have a board that supports QE for AFE. QE for AFE is connected between PC and 
the board through a USB cable and communicates with the board. 

 

1.2 Functions 

The main functions are listed below: 

1. Connect and operate the evaluation board 

2. Config AFE-related registers with GUI 

3. Display graphics of the AFE tuning results and digital filter frequency response 

4. Display graphics of the user application measurement values 

5. Generate code with RX SmartConfigurator or RA FSP when working as e2 studio plug-in 

 

1.3 New Functions 

1.3.1 Support RA2A2 

QE for AFE V2.2.0 starts to support RA2A2. 

 

 

Figure 1-1.  Support RA2A2  
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1.3.2 Support [AFE Overview (QE)] view 

A [AFE Overview (QE)] page is newly supported in the Stand-alone version, which makes it easier to open 
help documents, release notes, and download the sample program by clicking the links on this page. 

 

Figure 1-2.   [AFE Overview (QE)] view 

 

1.3.3 Improve workflow when working in e2 studio 

In previous version, “Disconnect” button is in the “Connect to Board” step of workflow. From V2.2.0, a new 
step “Disconnect from Board” is added at the end of workflow when working in e2 studio. In this way, it is 
more in line with the user's actual operation sequence. 

 

Figure 1-3.  [Disconnect from Board] in workflow  
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1.3.4 Specify adjustment program download location in e2 studio [Preference] menu 

The adjustment program download location can be specified in e2 studio menu: 

[Windows] > [Preferences] > [Renesas] > [Renesas QE] > [QE for AFE]. 

Using this setting page, the download location can be changed, and the downloaded package can be found 
under the specified folder.  

If You create a [Target Board Name] folder in this location and place a adjustment program (zip file) that 
corresponds to the target board, this adjustment program will be displayed in the [Select program for AFE 
adjustment] combo box list. 

Folder structure: 

➢ For RA2A1: {Path specified in [QE for AFE]}/RA2A1/xxxx.zip 

➢ For RX23E-B: {Path specified in [QE for AFE]}/RX23EB/xxxx.zip 

➢ For RA2A2: {Path specified in [QE for AFE]}/RA2A2/xxxx.zip 

 

Figure 1-4.  To specify adjustment program download location 

 

1.3.5 Eliminate the limitation of installation path 

The limitation that QE for AFE will not work properly if the installed location folder name starting with "u" 
(lowercase) is eliminated from V2.2.0. 

 

1.3.6 Eliminate the limitation of using e2 studio installation package 

The limitation that RX and RA device families must be selected when using e2 studio installation package is 
eliminated from V2.2.0. 
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1.4 Supported Environment 

 RA2A1 

➢ Windows 10 (64-bit version), Windows 11 (64-bit version) 
➢ Renesas e2 studio 2024-01 and later 
➢ Evaluation board: EK-RA2A1 
➢ RA2A1 Group Board Control Program for “QE for AFE” in application note R01AN5795EJ0200 

Note: Board control program should be built with FSP3.6.0. 
 RX23E-B 

➢ Windows 10 (64-bit version), Windows 11 (64-bit version) 
➢ Renesas e2 studio 2024-01 and later 
➢ Evaluation board: RSSK RX23E-B 
➢ RX23E-B Group Board Control Program for “QE for AFE” in application note R01AN6364EJ0100 

 RA2A2 

➢ Windows 10 (64-bit version), Windows 11 (64-bit version) 
➢ Evaluation board: EK-RA2A2 
➢ Renesas e2 studio 2024-01 and later 
➢ RA2A2 Group Board Control Program for “QE for AFE” in application note R01AN7280EJ0210 

Note: The board control program should be built with FSP5.2.0. 
 

1.5 Supported Microcontrollers 

• RA Family (only MCUs that incorporate the AFE) 

⎯ RA2A Series: RA2A1, RA2A2 

 RX Family (only MCUs that incorporate the AFE) 

⎯ RX200 Series: RX23E-B 
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2. Installation and Uninstallation 

2.1 Installing This Product 

Use either of the following procedure to install this product. 
 

2.1.1 Install from the "Renesas Software Installer" menu of e2 studio 

1. Start e2 studio. 
2. Select the “Renesas Views” - “Renesas Software Installer” menu of e2 studio to open the “Renesas 

Software Installer” dialog box. 
3. Select the “Renesas QE” and click the “Next >” button 
4. Select the “QE for AFE (v2.2.0)” check box and click the “Finish” button. 
5. Check that the “Renesas QE for AFE” check box is selected in the “Install” dialog box and click the 

“Next >” button. 
6. Check that the “Renesas QE for AFE” check box is selected as the target of installation and click the 

“Next>” button. 
7. After confirming the license agreements, if you agree to the license, select the “I accept the terms of the 

license agreements” radio button, and click the “Finish” button. 
8. When the dialog box for selecting a trusted certificate appears, check the displayed certificate, and then 

click on the “Trust Selected” button to continue installation. 
9. Restart the e2 studio by following the instructions on the screen. 
10. Start this product from the “Renesas Views” - “Renesas QE” menu of e2 studio. For details about how to 

use this product, see the “Help” menu of e2 studio. 
 

2.1.2 Install using QE (zip file) downloaded from the Renesas website 

A downloaded zip file has both a plugin version and a standalone version. 

 

2.1.2.1 Install Plugin Version 

1. Extract the downloaded zip file. 
2. Start the e2 studio. 
3. Click on “Help”, and then click on the “Install New Software...” menu item to open the “Install” dialog box. 
4. Click on the “Add...” button to open the “Add Repository” dialog box. 
5. Click on the “Archive...” button, select the installation file (zip file under the QE-AFE folder) in the 

opened file selection dialog box, and then click on the “Open” button. 
6. Click on the “Add” button in the “Add Repository” dialog box. 
7. Expand the “Renesas QE” item shown in the “Install” dialog box, select the “Renesas QE for AFE” 

check box, and then click on the “Next>” button. 
*If you check off the “Contact all update sites during install to find required software” checkbox, you can 
shorten the installation time. 

8. Confirm that the installation target is “Renesas QE for AFE”, and then click on the “Next>” button. 
9. After checking the license, select the “I accept the terms of the license agreements” radio button if you 

agree it, and then click on the “Finish” button. 
10. When the dialog box for selecting a trusted certificate appears, check the displayed certificate, and then 

click on the “Trust Selected” button to continue the installation. 
11. Restart the e2 studio by following the instructions on the screen. 
12. Start this product from the “Renesas Views” - “Renesas QE” menu of the e2 studio. For details about 

how to use this product, see the “Help” menu of e2 studio. 
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2.1.2.2 Install Standalone Version 

1. Extract “.zip” file to a user-specified location on the PC.  

Note: Please do not put the tool under OS program folder (C:\Program Files) 

2. Start this product by double clicking “\QE-AFE\eclipse\ qe-afe.exe”.  

3. For the first time this product starts, there is a dialog of license agreement. After checking the license, 

you can select “Agree” or “Disagree”. 

Figure 2-1.   License agreement dialog 

 

4. If “Agree” is selected in above step, the product is launched then you can use it; if “Disagree” is selected 

in above step, the product won’t be launched. 

 

2.2 Updating This Product 

If you have already used this product, you can update it in the same way as the procedure for installation. 

 

2.3 Uninstalling This Product 

Follow the procedure below to uninstall this product. 

 

2.3.1 Uninstall Plugin Version 

1. Start the e2 studio. 
2. Select “Help -> About e2 studio” to open the “About e2 studio” dialog box. 
3. Click the “Installation Details” button to open the “e2 studio Installation Details” dialog box. 
4. Select “Renesas QE for AFE” displayed on the “Installed Software” tabbed page and click on the 

“Uninstall...” button to open the “Uninstall” dialog box. 
5. Check the displayed information and click on the “Finish” button. 
6. Restart the e2 studio by following the instructions on the screen. 

 

2.3.2 Uninstall Standalone Version 

Delete the entire folder which .zip package is extracted. 

.  
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3. Notes / Restrictions 

3.1 Usage Considerations 

Please pay attention to the following items. 

Table 3-1   List of Limitation                                                                     ✓: Applicable, -: Not Applicable 

No Description 

R
A

2
A

1
 

R
X

2
3

E
-B

 

R
A

2
A

2
 

1 Notes on reading Board Control Program application note ✓ ✓ ✓ 

2 Notes on pressing [Write Value to The Target Board] button after configuring an AFE component 
setting 

✓ - ✓ 

3 Notes on ADC One-shot and Auto mode selection on [Monitor] View  ✓ - ✓ 

4 Notes on closing [AFE Monitor (QE)] view of e2 studio plugin version ✓ ✓ ✓ 

5 Notes on OPAMP trimming function failed using Emulator connection ✓ - - 

6 Notes on downloading AFE adjustment project ✓ ✓ ✓ 

7 Notes on monitoring RA2A2 SDADC24 conversion result - - ✓ 

 

3.1.1 Notes on reading Board Control Program application note 

QE for AFE works with the control program operating on the evaluation board. So when using this product, 
please read the related Board Control Program application note first and use the recommended parameters 
in the application note. The parameters to be concerned include: 

⚫ System clock setting 

⚫ Sampling time of communication I/F 

⚫ Default bitrate setting of UART connection 

 

3.1.2 Notes on pressing [Write Value to The Target Board] button after configuring an AFE 
component setting 

It is recommended to press [Write Value to The Target Board] button each time completing one AFE 
component configuration and move to next AFE component configuration. The reason is that the board 
control program checks the validity of the new register value according to the existing register value on the 
evaluation board. Keeping the register values on the evaluation board always consistent with the GUI 
configuration can avoid unexpected errors when writing new registers values to the evaluation board. 
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3.1.3 Notes on ADC One-shot and Auto mode selection on [Monitor] View  

ADC has 2 monitoring modes: One-shot and Auto. The waveform of these 2 modes is depending on ADC 
sampling time setting: 

◼ When ADC sampling time is short (performing high-speed conversion) 

       One-shot mode: QE for AFE reads data from evaluation board and draws the waveform only once 

       Auto mode: QE for AFE reads data from evaluation board and draws the waveform continuously until the 
"Stop AFE Monitoring" button is pressed 

◼ When ADC sampling time is long (performing low-speed conversion) 

Either One-shot mode or Auto mode, the waveform are same: QE for AFE reads data from evaluation 
board and draws the waveform continuously until the "Stop AFE Monitoring" button is pressed.  

Note: for detailed procedure of One-shot measurement and Auto measurement, please refer to RA2A1 board 
control program application note chapter “1.1.2 Measured Value Transmission Operation during A/D 
Conversion and Comparison” 

 

3.1.4 Notes on closing [AFE Monitor (QE)] view of e2 studio plugin version 

In e2 studio plugin version, if multiple [AFE Monitor (QE)] views are open under different perspectives,  
closing one [AFE Monitor (QE)] view while the monitor is running, the monitor won’t be stopped (the tuning 
result still can be observed after switching to another perspective). Closing the [AFE Monitor (QE)] view of all 
perspectives can end the tuning process. 

 

3.1.5 Notes on OPAMP trimming function failed using Emulator connection   

When using Emulator connection mode, OPAMP trimming function occasionally fails. The failed 
phenomenon is that even click “Next” and wait a while on Step1 or Step2, the wizard can’t move to next step. 
So to execute OPAMP trimming function successfully, please take priority to use USB or UART connection 
mode. 

 
Figure 3-1  OPAMP trimming function dialog 
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3.1.6 Notes on downloading AFE adjustment project 

1. To download AFE asjustment project, please kindly take note to set the region using the following steps. 
Otherwise, project can’t be downloaded. 

1) Select [Window] > [Show View]>[Smart Browser] menu. 

2) Select [Setting] in the Smart Browser [View menu]. 

3) Select one region in the settings dialog and click [Apply and Close] button. 

 

Figure 3-2 (a)  Smart Browser Region setting 
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2. If there is no adjustment program displayed in the download list after you selected the [Download AFE 
Adjustment Project] in the AFE Workflow (QE), you can follow the steps below to download the AFE 
adjustment program from Renesas website and place it in the specified folder manually. 

1) Download the AFE adjustment program for the target board you want to use from the Renesas 
website. 

➢ RA2A1: RA2A1 Group Board Control Program for 'QE for AFE' (R01AN5795EJ0200) 

➢ RX23E-B: RX23E-B Group RSSKRX23E-B Board Control Program Application Note 
(R01AN6364EJ0100) 

➢ RA2A2: RA2A2 Group Board Control Program for 'QE for AFE' (R01AN7280EJ0210) 

2) Place the downloaded zip file in the folder specified in [Window] > [Settings] > [Renesas QE] > 
[QE for AFE] under the following conditions. 

Folder structure: 

➢ For RA2A1: {Path specified in [QE for AFE]}/RA2A1/xxxx.zip 

➢ For RX23E-B: {Path specified in [QE for AFE]}/RX23EB/xxxx.zip 

➢ For RA2A2: {Path specified in [QE for AFE]}/RA2A2/xxxx.zip 

Figure 3-2 (b)  Operation when the AFE adjustment program is obtained from the Web  
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3.1.7 Notes on monitoring RA2A2 SDADC24 conversion result 

RA2A2 SDADC24 sampling rate is high, which leads to a large amount of conversion results.  The large 
amount of data consume a lot of PC memory and have an impact on the waveform drawing performance. To 
ensure drawing waveform real-time, the following restrictions are applied when performing  SDADC24 
mornitoring function: 

1) The waveform “Auto scaling” option is disabled during monitoring. 

Figure 3-3 (a)  “Auto scaling” option is disabled 

 

2) The monitoring time is limited within 5 minutes. When the time is up, monitoring automatically stops and 
outputs a message in console view. 

Figure 3-3 (b)  Monitoring automatically stops 

  



QE for AFE V2.2.0 Release Note 

R20UT5466EC0100  Rev.1.00   Page 14 of 19 

Mar.14.24  

In some cases, the message “[Error] STOP command failed to execute.” is output in console view 
together. When you met this case, please click “Stop AFE monitoring” button manually.  

Figure 3-3 (c)  Stop monitoring manually 
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3.2 Functional Restrictions 

The following restrictions apply to QE for AFE V2.2.0. These restrictions will be solved in the next or future 
version. 

Table 3-2   List of Restrictions                                                                     ✓: Applicable, -: Not Applicable 

No Description 

R
A

2
A

1
 

R
X

2
3

E
-B

 

R
A

2
A

2
 

1 Restrictions on showing a video about how to use QE AFE - ✓ ✓ 

2 Restrictions on ACMPLP configuration ✓ - - 

3 Restrictions on migration pin allocation to Smart Configurator - ✓ - 

 

3.2.1 Restrictions on showing a video about how to use QE AFE 

The video is not ready for publish, so you can't open the video even if you press the video button.  

Figure 3-4   Video button 

[Workaround] 

Please wait for the video content published. 
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3.2.2 Restrictions on ACMPLP configuration 

◼ “DAC8 channel 0 output” is selected as ACMPLP0 input (refer to figure3-5 (1)) 

➢ When switcher (A) selects Vref (refer to figure3-5 (A)) 

➢ When ACMPLP0 is disabled (refer to figure3-5 (D))  

➢ When switcher (B) selects IVREF0, switcher (C) selects Vref (refer to figure3-5 (B) and (C)) and 
ACMPLP1 is enabled (figure3-5 (E) selects “Enable”) 

Figure 3-5   ACMPLP1 example setting 

 

Either of above ACMPLP0 settings will cause the register value cannot be successfully written to the EK-
RA2A1 board with the following 1) – 3) settings. 

1) Set P013 as DA8_0 function in DAC8 page (P013PFS = 0A018000)  

Figure 3-6   DA8_0 example setting 

  

(1) 

(2) 

(A) 

(B) 

(C) 

(D) 

(E) 
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2) Select DA8_0 as OPAMP1 input in OPAMP page (AMP1PS = 80) 

Figure 3-7   OPAMP example setting 

 

3) Select ”DAC8 channel 0 output” as input in ACMPHS page (CMPSEL1 = 08)  

Figure 3-8   ACMPHS example setting 

 

[Workaround] 

In above ACMPLP0 setting, (1) setting is invalid. So please change (1) from “DAC8 channel 0 output” to 
“CMPREF0”. 

 

◼ “DAC8 channel 1 output” is selected as ACMPLP1 input (refer to figure3-5 (2)) 

➢ When switcher (B) selects IVREF0 (refer to figure3-5 (B)) 

➢ When switcher (C) selects Vref (refer to figure3-5 (C)) 

➢ When ACMPLP1 is disabled (refer to figure3-5 (E))  

Either of above ACMPLP1 settings will cause the same limitations 1) and 2) as selecting” DAC8 channel 0 
output “above. 

 

[Workaround] 

In above ACMPLP1 setting, (2) setting is invalid. So please change (2) from “DAC8 channel 1 output” to 
“CMPREF1”. 
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3.2.3 Restrictions on migration pin allocation to Smart Configurator 

When reflecting AFE setting to Smart Configurator, in certain case, the pin allocation in QE for AFE might be 
lost in Smart Configurator [Pin] > [Pin Funcions] setting. 

 

Figure 3-9 Mising pin allocation 

[Workaround] 
After “Generate AFE Setting” operation, please open Smart Configurator [Pin] > [Pin Funcions] and check. If 
the AFE module on the left tree display an error, then manually select the pins on the right table according to 
QE for AFE setting.  

Figure 3-10 Select the pins manually 

 

  

AFE connection (QE) 

Smart Configurator  
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 

2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 

3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 

4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 

5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 

6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 

7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 

8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 

or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 

document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 

or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 

manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 

and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 

each Renesas Electronics product depends on the product’s quality grade, as indicated below. 

 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 

 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 

Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 

human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 

system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 

disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 

that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 

hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 

not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 

ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 

RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 

HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 

ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 

PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 

RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 

THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 

Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 

specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 

products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 

injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 

safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 

aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 

responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 

controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 

applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 

with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 

promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 

subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
 

(Rev.5.0-1  October 2020) 
 

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 

Koto-ku, Tokyo 135-0061, Japan 

www.renesas.com 

 For further information on a product, technology, the most up-to-date 

version of a document, or your nearest sales office, please visit: 

www.renesas.com/contact/. 

Trademarks   

Renesas and the Renesas logo are trademarks of Renesas Electronics 

Corporation. All trademarks and registered trademarks are the property 

of their respective owners. 
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